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New Relative References

This option enables you to decide if you want your macros to be recorded with absolute or relative cell 
references. If you record a macro that copies the value in the cell A13 and pastes it in A1 using the 
relative cell references if you invoke the macro when your cursor is at B13, it will copy the value in B13 
and place it in B1.
If, however, you had used absolute cell references when recording your macro, the value in A13 would be 
copied to A1 irrespective of where your cursor was currently located.    By default, Excel uses absolute 
references when recording macros.
The relative reference of the cell at the top left corner of the worksheet is: A1. By contrast, the absolute 
reference to that same cell is: $A$1.



Add-Ins

The Add-Ins menu item on the Tools dialog enables you to see which of the available Excel add-ins you 
are currently running. Excel uses add-ins to extend its functionality, and indeed, many of the menu items 
in Excel will simply not appear if the relevant add-in is not installed and ready for use. A prime example 
would be the Access Forms menu item, which will not appear on the Data menu, even if you have got 
Access installed, if you haven’t installed the add-in.



Alignment

This command enables you to align text in one of four ways:

Left Alignment

Centred

Right Alignment

or Fully Justified, or Aligned, whereby each line is exactly the same length as the next, effectively being 

both Right and Left Aligned at the same time.



Annotate

A PowerPoint feature that enables you to draw and write on slides while you are giving a presentation.



Annotations

An annotation is something that you can insert into a Word document, rather like a note, that is normally 
invisible, unless you choose to view it. This feature enables you to annotate documents with comments 
that are preceded by your initials, and by a number that increments as you add more.



Answer Wizard

The Answer Wizard is a cross-program Wizard that makes finding out how to do something in Office 95 a 
simple matter of invoking the Wizard, and typing “How do I” followed by whatever it is you want to do. 
Thus, typing “How do I open files” will provide you with a whole list of items to choose from, all geared up 
to answering your query.



Audit
See Also...

Excel's Auditing tools enable you to quickly view the relationships between cells on your worksheets, and 
can help you trace any errors that might have occurred in those relationships, such as a formula not 
producing the expected results.



AutoCalculate

AutoCalculate lets you select a group of cells, regardless of whether that is a contiguous group or not, 
and will then calculate the sum of those cells. In fact AutoCalculate will not only show you the Sum, but 
also the Average, Max, Min, Count, or Count Nums (those are cells containing numbers) of the current 
selection.



AutoClipArt

PowerPoint can help you with the selection of clipart images to use in your presentation. After selecting 
this command, a dialog box will appear on screen telling you that PowerPoint has examined your 
presentation, and has come up with a number of clipart images that you may wish to employ on your 
slides.



AutoComplete

This feature looks at what you are typing in an Office 97 document and if it matches say, the contents of a 
cell in a worksheet, the cell you are typing in gets automatically filled with the contents of the other cell. If 
you don’t like that, you can just carry on typing.



AutoContent Wizard

The AutoContent Wizard gets you quickly on your way to creating a presentation in PowerPoint. It asks 
you for a number of details, such as your name, your company name, what the presentation will be about, 
the visual style for your presentation, how long you anticipate the presentation taking, and the type of 
output for your presentation.
Once you have filled in all these details, the Wizard will go away and create a presentation for you based 
on those entries. You can then set to work modifying the created presentation to better suit your 
immediate requirements.



AutoCorrect
See Also...

By default, Word for Windows 97 automatically checks for spelling errors as you type. Some errors, such 
as typing "t e h" instead of "t h e" are automatically corrected.



AutoFilter with Top Ten

AutoFilter with Top Ten is an improvement to the old AutoFilter function. If you need a quick look at the top 
ten best selling products in your line, or the top ten best customers that you have, the new AutoFilter with 
Top 10 feature in Excel will present those details to you in seconds.
The AutoFilter dialog works with both Items and Percentages, and you can change the Top number from 
10 to any number that you choose, and you can also use the dialog to select the Bottom 10 (or whatever 
number you choose) Items or Percentages.



AutoFormat

This function enables you to apply a range of pre-cooked formats to a variety of items in all the Office 97 
applications. There are, for example, pre-cooked formats for table designs, forms, reports, and so on. 
Once you have used the AutoFormat functionality, you can then go and modify any of its effects to better 
suit your immediate needs.



AutoHide

Use the AutoHide function on the Microsoft Office Shortcut Bar to stop it from appearing on top of all 
active items on the Windows 95 Desktop, at all times. With this function enabled, the Shortcut Bar will 
disappear behind the window of the active application if that window is placed over it.



AutoLayout

The AutoLayout dialog enables you to select the type of slide that you would like to use first in your new 
presentation. Each slide type appears in thumbnail view so that you get an idea of what it will look like 
when it appears, and you can also see what the PowerPoint developers thought it might be used for as its 
descriptive name appears in a small window on the right hand side of the dialog.



AutoRecover

Word enables you to have all your documents automatically saved as you work on them. You can set the 
amount of time between automatic saves, the minimum time period being one minute.
Excel also enables you to do this, but you have to install an Add-In before you can implement its 
functionality.



AutoSum

The AutoSum <S> button lurks on the Standard Toolbar, next to the Function Wizard button in Excel. To 
use this function, select a group of numbers, and then click on the button. The sum of the values in the 
selected cells will appear in the next cell, either horizontally, or vertically, depending on the orientation of 
the selected cells.



AutoText

Word enables you to select sections of text and/or graphics, and then save them as AutoText entries. 
Once you have created an AutoText entry, you can assign a character or word to that entry, and then just 
type the character or word, and then press the <F3> button. The AutoText entry will then appear in your 
Word document.



Bitmap

A graphical image. Created in Paint, for example



Binder

The Microsoft Binder is a tool that goes one step further towards the goal of integration by providing you 
with a method of storing files from Excel, Word, PowerPoint and Access in one location. Indeed, one 
location is perhaps too simplified, because what you are actually doing is storing files from the Office 97 
applications inside a Binder file, and not just Microsoft Office 97 application files either. If other vendors 
create applications that support the Binder, then you will be able to insert their files into the Binder as well.
The Binder application can be thought of as an Object Linking and Embedding (OLE) 2.0 Client 
application.



Bookmark

Bookmarks are highly useful items that are used to place a marker at a particular point in your Word 
document. You create them by selecting a particular piece of text, or a particular graphic in your 
document, and then invoke the Bookmark dialog from the Edit menu. You can then return to those 
markers at any time by using the Go To or Bookmark menu items on the Edit menu.



Briefcase

An application supplied with Windows 95, capable of ensuring the automatic updating of files, usually 
between a portable, and a desktop computer.



Bullet

An item used to highlight sections of text, to bring attention to them, as below:

·    They are most effective when used sparingly

·    If you need to use them all the time then it is a good idea to change the type of bullet, or number, that 

you use



AutoPick

A feature in Microsoft Outlook that automates meeting planning by searching for a time slot that is 
available for all the selected attendees.



Cascading Menu

Menus that are activated from the side of another menu, when a particular menu item is selected. The 
presence of a Cascading Menu is indicated by a triangle tipped on its side, located to the right of a menu 
item.



Cell

Worksheets in Excel are made up of a series of cells. The border of each cell is indicated by a non-
printing grid, divided into columns and rows. Each entry that you make to a worksheet via the keyboard is 
typed into a cell.



CellTips

CellTips is a feature that enables you to hold your mouse pointer over the red dot that indicates that a 
note has been attached to a cell, and then pops up the note so that you can read it. If a sound byte has 
been added to the cell, CellTips will play the sound file as well as displaying any text in a note.



Character Map

A Windows utility that enables you to select characters in a particular font, and then copy them to the 
application that you are currently working in.



Chart

A graphical representation of data from an Excel worksheet.



Chart Wizard

A Wizard that walks you through the required steps needed to create a chart in Excel.



ClipArt
See Also...

Artwork supplied with an application that you can make use of, in order to provide an image that 
represents, perhaps, the subject matter for a piece of text.



ClipArt Gallery

(see Microsoft ClipArt Gallery)



Data Point



Cross-reference

The Insert Cross-reference command in Word, enables you to insert a cross-reference to an item in your 
document. For example, say you have a heading in your document, you can then insert a cross-reference 
to the Heading Text, a Page Number, or to a Heading Number. There are a number of different items that 
can be used as a basis for a cross-reference, and each has a subset of items that the reference can be 
applied to.



Axis

Refers to the axis of a chart or graph. The x-axis runs horizontally along the bottom, while the y-axis runs 
vertically from bottom to top.
The Insert Axes option in Excel enables you to display both the Category (X-Axis) and/or Value (Y-Axis) 
axes on your chart. For example, if you have a small table that you have charted, with “May”, “June”, 
“July” as column headings, selecting the Category (X) Axis option from the Axes dialog will show those 
names along the bottom of the chart.
Selecting the Value (Y) Axis option on the dialog, will display a vertical row of numbers on the left hand 
side of the chart, whose maximum figure is equal to or slightly greater than the maximum value in your 
table.



Data Labels

Data Labels can be added to any Excel chart. They are used to complement the standard chart labels 
that you would normally find on the x and y axes of a chart.



Data Map

(see Microsoft Data Map)



Data Point
See Also...

An individual item of data, in a data series in an Excel chart. For example, a single data point on a column 
in a row of columns in a column chart.



Data Series
See Also...

A series of data in an Excel chart. For example, a set of coulmns relating to one plot value (for example, 
the values plotted for "Sales"), in a column chart.



Dialog

A window, usually not sizeable, that pops up on screen in response to a command, such as those issued 
from a menu item.
For example, invoking the Font menu item on the Format menu in Word, produces the Font dialog on 
screen.



Dialog Tips

If the dialog you are looking at has a question mark <?> symbol in the top right corner, next to the Close 
<X> button, you can click on the question mark, and then on any item in the dialog. A small window will 
pop up, containing up to 255 characters that describe the function of the item you just selected.



DocObjects

DocObjects is an extension to Object Linking and Embedding (OLE) 2.0. This is the technology that 
enables you to place Word, PowerPoint, or Excel documents as sections in an Office Binder. It does this 
by enabling any document to act as a separate object, complete with all its styles and print settings.



Document

The generic term for a file used in both Windows 95 and Office 97. A PowerPoint presentation file is now 
known    as a document, in exactly the same way that a Word word processing file is also known as a 
document.



Document Properties

All the Office 97 applications enable you to monitor the properties of any document that you work with. 
There are several types of properties, including General, which holds data relating to the creator of the 
document, and Statistics, which holds data pertaining to the length of the document, the amount of time it 
has been in editing format, and so on.



Document Viewers

A set of viewers that enable you to view the contents of a document, without having to run the application 
that created it, or indeed, even have that application on your system.



Drag and Drop

The method whereby you can select objects with your mouse pointer, hold down the mouse button, and 
"drag" those objects to a new location, before releasing the mouse button, and "dropping" them into 
place.



Drag and Plot

The ability to drag data from an Excel worksheet, and drop it onto an existing chart, which will then 
automatically plot the new data.



Drop Caps

A methof of starting a Word document, whereby the first letter of the document is set to be much larger 
than the remainder of the following text, the next two or three lines appearing to butt up against the large 
letter on the first line.



Embedded Object
See Also...

An OLE Object that has been placed in an OLE Client application by an OLE Server or OLE Client/Server 
application. This type of object physically exists in the host file, as opposed to the Linked Object, which is 
a placeholder containing merely a reference to the source file.



Endnotes
See Also...

Endnotes are numbered notes that can be inserted at the end of a Word document.



Equation Editor

(see Microsoft Equation Editor)



Error Bar

Error Bars provide a graphical representation in an Excel chart of potential error (or degree of uncertainty) 
amounts. The error amounts are always relative to each data marker in a data series.



File Viewers

File Viewers give you the ability to examine the contents of a file, without having to run the application that 
created it.



Folder

A folder is a container of objects such as documents, executables, batch etc. You can rearrange the 
contents of folders, move objects between folders, delete objects in folders, etc...



Font
See Also...

A set of characters that make up one member, or style, of a particular typeface. The character set 
includes all letters (A to Z) in both upper and lower case; numbers; and other symbols.



Font Family
See Also...

A collection of typefaces that have similar characteristics. For example: Arial, Arial Narrow, Arial Bold, Arial 
Italic, Arial Bold Italic are all typefaces derived from the same font family.



Fonts Folder
See Also...

Look in here to find the Fonts stored on your system.



Footer

Footers are always there in your document, but they are effectively invisible until you use them. They sit 
between the bottom edge of the text on a page, and the bottom edge of the paper. You can place 
graphical images in them, page numbers, dates, anything you like in fact. Often used in conjunction with 
Headers.



Footnotes
See Also...

Footnotes are numbered notes that can be inserted at the end of each page in a Word document.



Form Field

Microsoft Word supplies you with Form Fields to use when you wish to create a locked document, where 
only the form fields can be accessed, and typed into. The remainder of the document will be secure from 
alteration. Available form fields include text boxes, check boxes, and drop-down combo boxes.



Formula

Formulas are used in calculation fields, or Excel cells to calculate values based on the contents of the 
formula.
Example:
=SUM(A1+A2)
would add the contents of cells A1 and A2 and provide the result in the cell in which the formula was 
located.



Formula Bar

The bar that sits below the menu and button bars in Excel. It shows you the formula in the current cell.



Text Box

The Text Box is the Word 97 replacement for the old Frame. Using the Text Box instead of a frame gives 
you access to all the new OfficeArt features. Text Boxes can be used, for example, to keep text and 
graphics together, as you can have both text and graphics in a single Text Box.



Freeze

The ability, in Excel, to lock sections of a worksheet in place, so that when you scroll around the 
worksheet, the locked sections always remain visible.



Function

The generic term for pre-constructed formulas.



Goal Seek

The Goal Seek command on the Tools menu enables you to make changes to a value in a cell, until a 
formula that is dependent on that cell, reaches a pre-defined target value.



Graph

(see Microsoft Graph)



Gridline

A set of lines, both horizontal and vertical that define a grid-type shape.. They are usually non-printing.



Group
See Also...

The command that enables you to select a number of separate items, and join them so that they become 
one item.



Guides

A PowerPoint feature. Guides are used to enable you to easily align objects on a slide. They are non-
printing.



Handout

The ability to print PowerPoint presentations on pages, with one or more slides located on the page. You 
can have 2, 3, or 6 slides per page.



Handout Master

The Handout Master is a PowerPoint view that you can switch to, in order to specify the headers and 
footers that you would like to have appear on each handout page.



Header

Headers are always there in your document, but they are effectiveley invisible until you use them. They sit 
between the top edge of the text on a page, and the top edge of the paper. You can place graphical 
images in them, page numbers, dates, anything you like in fact. Often used in conjunction with Footers.



Hyphenation

The Hyphenation command on the Tools menu in Word enables you to automatically hyphenate words in 
your document, helping to reduce any raggedness at the end of lines in your document. This can be done 
both automatically and manually.



Icons

A small, representative, image of an object on your computer (Local), or on the Network to which you are 
attached.



Landscape



IntelliSense

Microsoft technology designed to make your life easier when working with your Office 97 applications. 
IntelliSense technology automates tasks, and is used in functionality such as AutoCorrect, AutoFormat, 
and AutoFilter.



Imager

(see Microsoft Imager)



Justification

(see Alignment)



Kerning

Kerning is the term used to describe character spacing between certain characters in certain words.



Landscape
See Also...

The orientation by which a page is printed on by your printer. This orientation means that the print area 
will run along the long (horizontal) dimension of a sheet of paper.



Legend

Legends are to be found on charts usually.. They are in text, and tell you what a particular color 
represents. For example, you might see a legend that tells you that all Blue items are "Sales for the 1st 
Quarter", etc...



Linked Object

An OLE Object that has been placed in an OLE Client application by an OLE Server or OLE Client/Server 
application. (see also Object Linking and Embedding). The object exists in the source file, rather than in 
the host file (see Embedded Object), and when the object is updated, the linked object is also updated to 
reflect the changes made.



Macro

The generic term for a series of orders, or commands, that are linked together, and when played back, 
enable an action of some kind to be carried out.
You might for example, create a macro that tells you how many words there are in a document, or a 
macro to print out a list of all the fonts installed on your system.



Mail Merge

The ability to create a letter in Word, and then print multiple copies of that letter, each with a different 
name and address on it. Mail Merge in Word may also be used to fill envelopes and labels with data as 
well.



Map

(see Microsoft Data Map)



Margin

The definition of the outer edges of the printed output on a sheet of paper. All four margins (top, bottom, 
left, right) are adjustable.



Master Document

Create a Master Document in Word to hold sub-documents. A n example of this would be if you were 
writing a book. Each chapter in the book would be in a sub-document of the main book Master Document.



Menu

A method of providing you with a selection of Menu Items to choose from. Menus are usually located 
below the Title Bar of an application, but can also be accessed by a Right Mouse Click.



Menu Item

An item on a menu. For example, Exit is normally a menu item on the File Menu of a program.



Message Box

A window that appears on screen, giving you information on an event that has taken place.



Microsoft ClipArt Gallery

The Microsoft ClipArt Gallery is a viewer that displays all the ClipArt supplied with your Office 97 
applications. New for Office 97 is its capability to show you pictures, videos and sounds located on your 
system as well. It displays each image in thumbnail format, and you simply scroll through the display until 
you find the ClipArt item that you desire, and then insert it into your active document. It is a shared 
application, available to any OLE-enabled application, via the Insert Object menu item.



Microsoft Data Map

A shared Office 97 application, mainly used in Excel, which enables you to provide a geographical 
representation of your data.
For example, you might create a map showing the locations of all your offices in a country, along with 
data that showed how well each office was doing.



Microsoft Equation Editor

A shared application that enables you to insert equations into your Microsoft Office documents. Invoked 
via the Insert Object command, the Equation Editor supports in-place editing.



Microsoft Graph

A shared application provided with the Office 97 suite that enables you to create simple graphs and charts 
to place in your documents.



Microsoft Imager

A shared application provided with the Office 97 suite that enables you to work with graphical images, 
modifying, displaying and generally applying a number of effects and functions to those images. Microsoft 
Imager is unique (at the moment) among the shared applications in that it can be run as a stand-alone 
application, and not just by being invoked from within an OLE-enabled application.



Microsoft Office Shortcut Bar

The Microsoft Office Shortcut Bar (MOSB) is the replacement for the old Microsoft Office Manager 
(MOM). From here you can create new documents, or open existing documents. You can create extra 
toolbars, beyond those supplied as standard, and the MOSB can be set to automatically hide itself behind 
active application windows.



Microsoft Organisation Chart

A shared application, supplied with the Office 97 suite that enables you to create organisation charts and 
embed them as objects in your documents.



Microsoft WordArt

The Microsoft WordArt shared application is provided with the Office 97 suite to enable you to apply fancy 
formatting to text in your documents.



Module

The term used to describe the location of Visual Basic for Applications (VBA) code.



My Documents Folder

The "My Documents" folder is the default location for documents created by Office 97 applications.



Name

In Excel, the ability to select a cell, or a range, or even a constant or a computed value, and to give it an 
easily recognisable name. Once you’ve done this, you can then use that name to refer to the item in 
question.



Nested Menus

(see Cascading Menus)



Normal

The Normal view in Word is the default view in Word for most word processing tasks. It enables you to 
see as much of your current document as possible, without the margins that you would see in Page 
Layout view.



Nonbreaking Hyphen

A Nonbreaking hyphen is used when you don’t want a hyphenated word, for example, “pre-defined”, to 
appear over two lines.



Nonbreaking Space

A Nonbreaking Space is one that you insert between two words in order to prevent a line break taking 
place.



Notes (Excel)

The Notes command enables you to insert a note into a cell. The note will then appear when you move 
the mouse pointer over the cell, thanks to the new CellTips feature. Cells with notes attached are 
recognisable as they have a small red dot in the top right corner.



Notes (PowerPoint)

You can switch to the Notes pages view in PowerPoint to add notes to each individual slide in your 
presentation. Those notes can then be referred to by you while you are giving a presentation.



Notes Master

The Notes Master view in PowerPoint enables you to set up the format you require for your Notes pages.



Object Linking and Embedding
See Also...

A programming technique whereby OLE-enabled programs are able to transfer, and share data.



OfficeLinks

Microsoft technology, enabling you to easily share, access and exchange data between the Office 
applications. An example of an OfficeLinks tool would be Present It.



OLE

(see Object Linking and Embedding)



OLE-enabled

An application that is either an OLE Client, OLE Client/Server, or OLE Server.



OLE Client

An application capable of storing OLE Objects placed in it by an OLE Server, or OLE Client/Server 
application, but incapable of producing those OLE Objects itself.



OLE Client/Server

An application capable of both storing OLE Objects supplied to it by an OLE Server application,    and 
creating objects itself.



OLE Object

An item of data supplied by an OLE-enabled application. For example, a chart from Microsoft Excel, 
Embedded, or Linked to a Microsoft Word for Windows document, is an OLE Object.



OLE Server

An application capable of supplying OLE Objects for placement in an OLE Client application, but 
incapable of storing OLE Objects itself.



Orphans
See Also...

Orphan control in Word, prevents the first line of a paragraph (an Orphan) from being printed all by itself 
at the bottom of a page.



Outline

An Outlined document is one where topics and sub-topics are placed at different indent levels.



Pack and Go Wizard

The Pack and Go Wizard is a useful tool provided by PowerPoint that enables you to put a slideshow 
onto floppy disks, so that you can take it with you to use on another computer, secure in the knowledge 
that you have all the linked files and fonts available to you, as you would have had were you giving the 
presentation on your own machine.



Page Break

A Word command that enables you to insert a hard page break. Word will now treat everyting above the 
break as a page, and anything below it as a page, and it will print as a spearate page.



Page Layout

(see Page Setup)



Page Setup

The generic term for a set of dialogs that enable you to control the layout of a document.



PickLists

An Excel feature that enables you to right mouse click on a cell, whereupon a list will appear containing 
all previous text entries in the column. Find the entry you desire, click on it, and it will be added straight 
into the current cell.



PivotTable

A PivotTable is an analysis tool in Excel that enables you to display your data in a variety of layouts. You 
can define an initial layout as to where column and row headings should be located, and you can then 
change these by dragging them around inside the PivotTable, thus proividing yourself with different views 
onto the same set of data.



Play List

You can create a play list of PowerPoint presentations in a word processor, and then save the document 
with a .LST extension. You can then open the document in the PowerPoint Viewer and select the name of 
the presentation that you wish to play.



Plot Area

The area on an Excel chart on which the columns, lines, scatter points etc.., rest.



Pop-up Menu

A Menu that springs into life on your screen, in response to a Right Mouse Click.



Portrait
See Also...

The orientation by which a page is printed on by your printer. This orientation means that the print area 
will run along the short (vertical) dimension of a sheet of paper.



Print Area

An Excel feature that enables you to select a range on a worksheet, and make that the only area that will 
be printed.



Print Job

Every time you print something, a print job is created. If you have many jobs to be printed, they will enter 
the Print Queue, and be printed in turn.



Print Preview

The functionality supplied with the Office 97 applications that enables you to see how a document will 
look before it is printed.



Print Queue

The queue created when there is more than one Print Job waiting to be executed.



Properties

(see Document Properties)



QuickView

Select this Menu Item to invoke the File Viewers. This menu item usually appears on a Pop-Up Menu.



Range

An area that you define by clicking and dragging on a worksheet. This then becomes a worksheet range.



Redo

Used in conjunction with the Undo command. This command enables you to repeat some of the actions 
that you undid with the undo command.



Regroup

This command enables you to put back into a group, a set of objects that you have ungrouped.



Repeat

This command enables you to repeat an operation, such as a formatting command, that you have just 
carried out.



Pointing Device

The device used by you to move your screen pointer. This is usually a mouse, but can also be a Pen, or 
some form of specialised pointing device, such as those used in Computer Aided Design (CAD) 
applications, on specialist drawing boards.



Present It

An OfficeLinks tool that enables you to use a PowerPoint presentation as the basis for a new Word 
document.



Revisions

A feature of Word that enables you to set a document up so that when alterations are made to it, revision 
marks are applied at the point where the revisions took place. This enables you to circulate a document 
amongst others, and then to see what alterations were made when the document returns to you.



Right Mouse Click

The action of clicking on an object on the screen, with the rightmost button on your mouse, or on the 
button assigned as the right mouse button, on an alternative Pointing Device.



Routing Slip

A Routing Slip is used in electronic mail to enable you to add the addresses of multiple recipients, as well 
as being able to add some message text.



Ruler

Rulers are usually located above and to the left of the working area. They enable you to quickly see the 
size and location of objects in a document. Ruler scales will vary depending on the settings for 
measurements in the International settings dialog in the Windows 95 Control Panel.



Scale

A generic term used to describe the sizing of an object against another object. For example, you can 
scale an image down in size, such that it retains the original image, but is much smaller in physical size.



Scenarios

Scenarios are data sets, created in Excel, that you can employ in order to see the results of what-if? style 
analysis.



Scrap

A Scrap is similar to a shortcut. In this case howver, you can drag a portion of a document onto the 
Windows 95 Desktop, where it becomes a "Scrap". You can then invoke the scarp by double-clicking on it, 
and you will be taken straight to the data in the scrap.



ScrollTips

ScrollTips put in an appearance in Excel, as well as in Word and PowerPoint. While the latter two show 
you what page or slide you are currently on, Excel’s ScrollTips work slightly differently. Click on the 
scrollbar button in Excel, and you’ll get a representation popping up that shows you the top row that 
would be visible were you to let go. Similarly, if you do that on the horizontal scrollbar, you’ll see the 
furthest left column that would be displayed.



Shortcut

Office 95 supports the Windows 95 metaphor of Desktop Shortcuts. Office 97 supports shortcuts from any 
of its document management dialogs. Just drag and drop with the right-mouse button. You can create a 
shortcut to a specific place in a file also by right-mouse dragging onto the Desktop.



Slide

The standard component of a PowerPoint presentation. Each presentation is made up of a series of 
slides (pages, if you prefer) that can display both text and graphics.



Solver

Solver is the Excel tool to use for finding the optimum solution to problems where the solution is 
constrained by a number of factors or demands.
Solver can determine the maximum value of one cell, based on changing values in another cell. Thus, 
you would use Solver to find out how much profit you could get when you change the amount you spend 
on advertising. All you need to bear in mind is that the two cells you select must be related to each other 
by existing formulas, otherwise any changes you make to one will not have any effect on the other.



SpellIt

SpellIt is the name for the automatic spell checker functionality in the Office 97 suite. It is part of the 
Microsoft IntelliSense technology.



Spike

The Word "Spike" is a rather neat function that enables you to cut several items at once from your 
document, and then paste them all together to a new location in either your current document, or another 
document all together.



Spreadsheet

The generic term for an application that is used mainly to work with numeric data.



Style

A Style is something that you define, and then apply to an item in your document. There are also default 
styles. For example, the Normal text style font in Word is defined as Arial, 10pt. You can modify the 
Normal style, or create a new style based on the Normal style, and give it a new name, and change the 
font and the font size.



Style Gallery

A dialog that provides you with a set of default styles that you can choose from, and then apply to objects 
in your documents.



System Requirements for Microsoft Office 97

Personal computer with a 386DX or higher processor (486 recommended) 
Microsoft Windows 95 operating system or Microsoft Windows NT Workstation operating system version 
3.51 or later (will not run on earlier versions of Windows) 
8 MB of memory required to run two programs on Windows 95; 12 MB of memory required to run 
Microsoft Access on Windows 95; 16 MB of memory required to run Access or two other programs on 
Microsoft Windows NT Workstation; more memory required to run additional programs simultaneously on 
Windows 95 or Windows NT Workstation. 
Hard-disk space required for Office Standard (approx): 28 MB compact, 55 MB typical, 89 MB complete 
Hard disk space required for Office Professional (approx): 40 MB compact; 87 MB typical; 126 MB 
complete (subject to change) 
One 3.5" high-density disk drive and a CD-ROM drive 
VGA or higher-resolution video adapter (SVGA 256-color recommended) 
Microsoft Mouse or compatible pointing device 



Table

The generic term for a grid-style outline made up of columns and rows divided into cells.



Table of Authorities

A Table of Authorities is where you show the reference works you used when compiling specific items in 
your Word document.



Table of Contents

A Table of Authorities is where you show the contents (chapters, etc...) of your Word document.



Table of Figures

A Table of Figures is where you show the names of the images you used within your Word document.



Table Wizard

A Wizard provided by Word that enables you to create a table that has more going for it than the standard 
table. Details that you can configure in the wizard include row and column formats, column headings, 
print orientation, and more



Tabs

Tabs, or Tab stops, are markers that appear on the horizontal ruler in Word. By pressing the <Tab> key on 
your keyboard you advance to the next defined tab stop, which by default are at predefined, regular steps 
on the ruler. Word enables you to drag and move tab stops, so that you can increase or decrease the 
amount of indent you apply when you press the <Tab> key.



Taskbar

A panel that shows you all the currently running applications and opened windows on your Windows 95 
system. You use the TaskBar to switch between these applications and windows.



Taskbar Items

An individual item on the Taskbar, indicating a program that is currently running on your system or an 
opened window.



Template

Templates are documents that come with a pre-defined layout and style. They are used as the basis for 
all new documents. You can use the default templates that ship with the Office 97 suite, or you can create 
your own, either by modifying the existing templates, or by creating new templates of your own.



Template Wizard with Data Tracking

Template Wizard with Data Tracking is a long title for one of the neatest features of the new Excel. 
Basically, what it means is that you can create a database on a central server, and distribute templates 
that mimic the data fields in that database to outlying sites. Users can then fill in their template forms at a 
remote site, and two copies of the new record will be created. One as a hard copy at the remote site, the 
other as a new record entry in the server database.



Thesaurus

A Thesaurus is a tool that enables you to find words that are similar in nature to the selected word.
For example, suppose you found that you were using the word word "anger" too many times in a 
document. You could invoke the Word Thesaurus, and it would provide you with a list of words that you 
could substitute in your document for the word "anger".



TipWizard

The TipWizard is an IntelliSense Wizard that examines what you are doing in a document, and then gives 
you advice as to how you could have completed the task, better, or faster.



Titles

A generic term used to describe headings of one kind or another in a document. Excel charts, for 
example, have titles, as do PowerPoint slides.



Title Master

The Title Master view in PowerPoint enables you to set the master styles for slides that use the Title 
layout.



Toolbar

The generic term used to describe the button bars in the Office 97 applications.



ToolTips

Small pop-up windows that appear when you hold the mouse pointer over an item (usually a button on a 
Toolbar), describing the functionality of that item.



Trace Errors
See Also...

The Trace Errors function in Excel enables you to quickly track down which cells have incorrect values in 
them, and are causing errors to appear in a cell on a worksheet.



Trace Dependents
See Also...

A dependent is a cell In an Excel worksheet that contains a formula that references other cells on the 
worksheet. The trace Dependents function enables you to quickly locate those cells.



Trace Precedents
See Also...

Precednets are cells on an Excel worksheet that supply the formulas in other cells with values. The Trace 
Precedents function enables you to quickly track down those cells.



Transition (Excel)

Excel functionality designed to make the move from Lotus 1-2-3 to Excel as smooth as possible.



Transition (PowerPoint)

The functionality in PowerPoint that enables you to create special effects that occur when you move from 
one slide to another. Effects available include animation, and sound.



Trendline

If you wish to make your Excel charts look really flash, a trendline or two is a must. These are lines that 
go from the top of one data point to the next, so if you have a column chart showing figures steadily rising 
each month, the trendline will extend upwards at an angle across the chart, emphasising the 
improvement.



Undo

Used in conjunction with the Redo command, this function enables you to undo an action that you have 
just completed. You might, for example, have accidentally deleted a portion of text in a Word document. 
Use the Undo command to restore the text to your document.



Ungroup

This functionality enables you to take an object that is made up of a series of objects grouped or 
regrouped together, and then to split them into the individual elements that they once were.



Widows
See Also...

Widow control in Word, prevents the last line of a paragraph (a Widow), from being printed all by itself at 
the top of a new page.



Windows Explorer

An effective replacement for the old Windows File Manager. It provides you with the ability to browse the 
Folders on your system, run searches for files, change views, delete, rename, copy, and move files etc... 
You can browse both local, and networked drives, as well as your Windows 95 or Windows NT 4.0 
Desktop.



Wizard
See Also...

An application, that is designed to take you through a series of well-prompted steps, making it easier for 
you to carry out certain tasks, such as the creation of charts, tables, and so on.



WordArt

(see Microsoft WordArt)



Workbook

The container that holds a set of worksheets. When you create a new file in Excel, you are getting a new 
workbook. Workbooks can also hold charts, macros and code modules.



Worksheet

Each Excel Workbook contains a number of worksheets, divided into a grid-style format where cells are 
created by the consecting lines of rows and columns.



WriteUp

A PowerPoint tool, part of the OfficeLinks technology, it enables you to automatically create handouts in 
Word, based on your current PowerPoint presentation.



Zoom

Functionality available in all the Office 97 applications that enables you to zoom in or out of your current 
document, deciding how much or little that you wish to see on screen at any one time.



Portrait



Slide Master

The Slide Master is the view you switch to in PowerPoint when you want to set slide properties such as 
fonts, colors, title and body text, or add logos that will appear on each slide, and so on.



Split

The ability to split document windows into two or more items, each of which can be scrolled 
independently.



Desktop

Your working area in Windows 95. Everything you see on your screen is on the Desktop.



Explorer

(see Windows Explorer)



Trace Dependents
Trace Errors
Trace Precedents



Exceptions List

Word 97 tracks and adds exceptions to an AutoCorrect Exceptions List on the fly. If you use the 
Backspace key on an AutoCorrect correction, Word 97 automatically places it on the Exceptions List. The 
next time you type that word, AutoCorrect will see that it is an exception and will not attempt to correct it 
for you.
If you wish to simply stop one AutoCorrect action, but don't wish to add it to the Exception List, as you 
may wish to use the functionality again, rather than using the <Backspace> key, go instead to the Edit 
menu, and select the Undo AutoCorrect menu item. You need to do this straight away.



Exceptions List



Active Window
See Also...

The window on the Desktop that is currently being worked on, and has the focus. Active windows are 
usually the Topmost window if there is more than one open, and have their Title Bar highlighted in a 
different color to that of any other open window.



Inactive Window
See Also...

A window on the Desktop that is currently not being worked on. It is generally not the Topmost window if 
there is more than one window open, but it may well be running a Task in the Background.



Topmost

The window that is currently at the top of the windows order on the Windows 95 Desktop. The Title Bar of 
the topmost window is usually highlighted in a different color to any other open windows.



Title Bar

The bar that runs along the top of an open window, usually containing the title of the program, or process, 
that is running in that window. It's color will vary depending on whether it is the title bar of the Active 
Window, or not.



Inactive Window



Active Window



Task

A task is either a generic term used to describe an action, or series of actions that need to be acrried out 
in order to achieve a pre-defined objective, or it is an individual item on the Windows 95 Taskbar, 
indicating a program that is currently running on your system.



Background

The background of the Windows 95 Desktop or the background of an Office 97 document You can 
change its color, and apply a pattern, a background Bitmap, or a combination of the two. Also refers to a 
Task that is currently running, but that does not have the focus.



Paint

An easy to use painting utility supplied with Windows 95.



Thumbnail

A Thumbnail is a representation of the contents of a much larger image, greatly scaled down to fit in the 
thumbnail. It is often used whn space is at a premium, and the application wishes to display as many 
images at once as possible. It is often used in applications that enable you to preview images, and then 
select an image to use or work on in your current application.



OLE Client
OLE Client/Server
OLE Object
OLE Server
OLE-enabled



Endnotes



Footnotes



Active Profile

The profile that you use in Microsoft Exchange during your current messaging session. It includes data 
such as the location of your inbox and outbox, your address lists and your personal folders.



Attachment

A file attached to a message sent via Microsoft Exchange.



Personal View

The ability, in Microsoft Exchange, to add or remove columns in folders, such that you can create your 
own customized setup for what you wish to see in a folder.



Data Marker
See Also...

The graphical representation of a data value in an Excel Chart, such as the column in a column chart, a 
pie slice in a pie chart etc...



Data Marker



Query

(see Microsoft Query)



Microsoft Query

An Excel Add-In program that enables you to retrieve data from external databases, filter the data in 
Microsoft Query, and then return the data to Excel for analysis.



MAPI

(see Messaging Application Programming Interface)



Messaging Application Programming Interface

A set of functions used by programmers to provide electronic mail capabilities to applications.



Microsoft Mail

Microsoft's electronic mail system that enables you to send mail to other people.



Microsoft Mail Postoffice

A centralised location on one computer that stores the addresses of all the users of a networked Microsoft 
Mail system. This is also the name of the utility, located in the Windows 95 Control Panel, that enables 
you to set up the Microsoft Mail Postoffice.



Microsoft At Work Fax

A fax program available for Windows which requires a Fax Modem.



Microsoft Exchange

The program used to access all the messaging systems on your machine. These include Microsoft Mail, 
Microsoft At Work Fax, and the Microsoft Mail Postoffice.



Fax Modem

A fax-modem is a modem capable of sending and receiving faxes using software on your computer to 
compose, send, receive, and view them.



Modem

A modem is a device that converts a stream of digital data from your computer into a stream of analogue 
signals suitable for transmission down a telephone-type circuit using a process called modulation. It can 
also demodulate an incoming stream of signals to deliver received data to your computer, allowing two-
way (duplex) data exchange over a single circuit



Shared Application

An application supplied with the Office 97 suite, and invoked via the Insert Object menu item. To use a 
shared application, such as Microsoft WordArt, you must be running an OLE-enabled application.
The only exception to this rule is the Microsoft Imager application which can be run as a stand-alone 
application in its own right.



VBA

(see Visual Basic for Applications)



Visual Basic for Applications

A programming language, based on Microsoft Visual Basic, and used within the Office suite in order to 
provide extra functionality. It is an extremely powerful labguage, and you can write code that can carry out 
actions as diverse as remote controling other Office 97 applications, to producing high-level data analysis 
programs in Excel, for example.



Constant

A term used to describe a fixed value, such as the boiling point of water.



PowerPoint Viewer

An application that enables you to show powerPoint presentations, without having to have PowerPoint 
installed on the computer that you are running the presentation on.



Trace Errors
Trace Precedents



Trace Dependents
Trace Errors



Answer Wizard
AutoContent Wizard
Chart Wizard
Pack and Go Wizard
Table Wizard
Table Analyzer Wizard
Template Wizard with Data Tracking
Tip Wizard



ClipArt Gallery



Font Family
Fonts Folder



Font
Fonts Folder



Font
Font Family



Regroup
Ungroup



TaskLinks

Part of the Office 97 IntelliSense technology. TaskLinks enable you to create Outlook tasks from within 
any Office 97 application.



Orphans



Widows



Trace Dependents
Trace Precedents



Browser

A software utility, like Microsoft Internet Explorer, that enables you to view World Wide Web pages on 
your computer.



World Wide Web

World Wide Web. The graphical view of the Internet. To access it you require a World Wide Web browser, 
such as Microsoft Internet Explorer.



Internet

A world-wide system of computers, connected via TCP/IP, which can be accessed by modem, giving you 
access to a huge range of data, and people.



TCP/IP

Transmission Control Protocol/Internet Protocol. The network protocol used to communicate with other 
TCP/IP systems, and UNIX-based Bulletin Boards, and electronic mail services.



Protocol

A set of rules and conventions that are employed by computers on a network, or modems, in order to 
pass messages between one another.



Network

A collection of computers, linked together either directly by cable, or remotely by modem, or another 
communications device.



Grammar Check

Part of the Office 97 IntelliSense technology. Microsoft Word 97 comes with a grammar checker that 
checks your documents for errors as you work.



Formula AutoCorrect

Part of the Office 97 IntelliSense technology. Microsoft Excel 97 automatically corrects the 15 most 
common formula errors.



Auto Web Link

Part of the Office 97 IntelliSense technology. When you type "http://..." into Access 97, PowerPoint 97, or 
Word 97, the programs recognise the prefix and establish a live link automatically to the URL you have 
just typed.



URL

Uniform Resource Locator. The "address" of a World Wide Web site, for example. Thus, the URL for the 
Microsoft Web site is:

http://www.microsoft.com



Expand Slide

Part of the Office 97 IntelliSense technology. Expand Slide is a PowerPoint 97 feature that when invoked, 
breaks all slides that have contents that extend beyond the physical confines of the slide, into new slides.



Table Analyzer Wizard

Part of the Office 97 IntelliSense technology. The Table Analyzer Wizard is used by Access 97 to 
recommend the best way to organize data in a relational database.



Statement Builder

Part of the Office 97 IntelliSense technology. Statement Builder is used by Visual Basic for Applications to 
enable developers to step through function parameters, saving you from having to memorize all the 
properties of a particular parameter.



Office Assistant

Part of the Office 97 IntelliSense technology. The Office Assistant (in fact there are several, and you can 
pick the one you want) either remains on screen observing your actions all the time, or can be invoked via 
the Help menu or the Standard toolbar.

The Assistant monitors what you are doing, and if it comes up with a suggestion, a light bulb will appear in 

the window, and it will probably wave something at you to get your attention.



IntelliMouse

Part of the Office 97 IntelliSense technology. The new Microsoft IntelliMouse is an advanced version of 
the old Microsoft Mouse that now sports a wheel located between the two buttons. This wheel, which can 
be rolled or clicked like a button, enables users of Office 97, Internet Explorer 3.0 and Windows 95 to 
greatly simplify the actions of zooming and scrolling.



OfficeArt

A new set of drawing tools that enable you to create graphic items in your Office 97 documents.



Command Bars

New for Office 97, Command Bars are a combination of the old menus and toolbars metaphor, with an 
enhanced user interface, and much greater customisability. Command Bars, for example enable the use 
of Tear-off Menus, and enable you to have both text and icons on the same bar.



Tear-off Menus

Part of the Office 97 IntelliSense and Command Bar technology. Tear-off Menus enables you to tear the 
menus and toolbars off Office 97 applications and place them on your Windows 95 or Windows NT 4.0 
Desktop.



Microsoft Clip Gallery Live

Located on the Microsoft Web site, Clip Gallery Live is accessible from links in PowerPoint 97 and 
Publisher 97. It provides you with access to over 2,000 additional ClipArt images, photos, backgrounds, 
sounds and video links.



Shared Workbook

Excel 97 now enables multiple users to work on the same workbook at the same time over a network.



Track Changes

New in Excel 97, Track Changes is a feature that color codes cell borders and annotations as they are 
changed, making it easy to see at a glance what changes were made to a spreadsheet.



ActiveX Controls

ActiveX controls (formerly known as OLE controls), can be embedded directly into Office 97 documents 
and forms.



Microsoft Forms

A tool provided with Visual Basic for Applications, and designed to make it easy for developers to create 
forms and dialog boxes in Excel 97, PowerPoint 97, and Word 97.



Shared Word Document

Multiple users can now edit the same document in Word 97, at the same time.



Web Toolbar

The Web Toolbar provides all Office 97 applications with browser capability.



FindFast Web Query

FindFast Web Query enables Office 97 applications to conduct full text searching of both HTML and 
Office documents, located on a network.



HTML

HyperText Markup Language. HTML is the language used by developers to create the pages that you see 
on Web sites via your Web browser.



Hyperlinks

Hyperlinks appear as underlined text, such as the text items on this page, that when clicked on "jump" 
you to another page in this Help file.
In another example, a URL to Microsoft's Web site might appear on a document as:

http://www.microsoft.com

You can however also create links between HTML files, or between other Office 97 documents. 
Hyperlinks can be attached to a variety of items in an Office 97 document, including:

Cells
Graphics
OLE Objects
PowerPoint Slides
Tables
Text



AutoSummarize

A tool provided with Word 97 that enables you to see a cut-down version of any document, with only the 
major points highlighted.



Range Finder

A feature of Excel 97 that uses colored frames to indicate which cells are referenced in a formula.



Comments

Comments can be inserted into any Office 97 application documents, and then viewed in pop-up 
windows, and edited as you so desire.



AutoShapes

New for Office 97, AutoShapes are a set of pre-defined shapes in a number of formats (lines, flowcharts, 
etc.) that you can use in your Office 97 documents.



Page Break Preview

An Excel 97 feature that enables youy to see a worksheet as it will be printed, each section clearly 
defined. You can move items between sections if they don't quite fit, enabling perfect printouts without 
overlaps.






